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Summary:  Compendium is a powerful hypertext tool for mapping and analyzing 
knowledge in multiple dimensions, but it is often useful to create reports from those maps 
that project rich hypertext structure into the linear bounds of a traditional document, i.e. 
“meeting notes”.  This is rarely a pushbutton process – there is considerable art and skill 
in creating a coherent narrative from the typical results of collaborative sensemaking.  
Nonetheless, this tutorial outlines the basic steps of printing out a map or series of maps 
as an outline in MS Word.   
 
These instructions are specifically for the Alpha1 version, which is not an official 
Compendium release.  It is available through the CogNexus Alpha Version web page.  
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Overview of the Process 
 
The basic process is simple and fast1: 
     Step 1:  Do an Export – Web Outline, creating an HTML file 
     Step 2:  Open the HTML file in Word and save it as a DOC file. 
However, there is some one-time customization needed to clean up the outline output. 
 
Note: This document was created using Word 2000 and tested in Word 2002.  Anything 
you do with MS Word that is at all unusual must allow for bugs in Word and 
idiosyncrasies between versions of Word – some fiddling may be required to get the 
results you need. 
 

                                                 
1  In previous versions of this paper I have described a 3-step process; the Alpha1 version eliminates the 
need for the middle step, and there is no longer a need for a Word template file (.dot) to specify the 
formatting for the various styles. 
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Nodes to Notes – The Default 
 
Here is a short example of the transformation from a map to text.  Suppose you had held 
a very short meeting in which the group had created the following simple map: 
 

 
Figure 1: A simple meeting map 

If from this map you did an Export Web Outline2 using the default settings in 
Compendium Alpha1, the result would look something like Figure 2.  
 

 
Figure 2:  Portion of Outline Export, in Word, using Compendium export defaults 

 
While you could certainly use this as the starting point for your report, there are several 
problems that you will probably want to correct: 
                                                 
2  The Export creates a temporary HTML file, which, by default, is placed in the Compendium Exports 
folder. 
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• It includes an interactive “navigation menu” (the smaller “Report Generation” at 
the top) which is meant to be used from a browser. 

• There is a lot of wasted vertical space between lines. 

• The styles that Word has used for the paragraphs are very difficult to work with in 
making formatting changes (although you can’t see this in the figure). 

• The node labels are in a large bold font that looks like headings (In Word, they 
ARE headings styles!) 

 
In short, it doesn’t look much like a “meeting notes” document.  The vertical spacing is 
especially problematic, because even a small map can run to several pages, and with a 
larger map it is sometimes difficult to keep track of outline indentation between pages.  
Instead, by choosing different settings in Compendium we can get a starting point in 
Word that looks like Figure 3.  This more compact presentation of the map takes no 
longer to produce, is easier to read, and makes a better starting point for the editing which 
will produce your finished meeting report. 
 
 

 
Figure 3: More compact outline output 
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Initial Set Up for Outline Exports 
 
This section describes how to set the parameters for Web Outline exports from 
Compendium.  You only need to do this once.  Even if you have multiple projects, these 
settings are preserved in your copy of Compendium until you change them. 
 

1. Start Compendium Alpha1 

2. Open the map that you want to create the report on (e.g. “Agenda”) 

3. Navigate the menus for File, Export, Web Outline 

4. Set up the “Node Selection” tab parameters to look like Figure 4. 

 
 

 
Figure 4: Outline Export settings -- Node Selection Tab 

Notes on “Node Selection” tab:   

• Usually you’ll want to include all submaps, thus the “Full depth” setting;  

• While the default setting for Open Export after completion is “off”, some 
users have this option turned on, but it is no longer necessary. 
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5. Set up the “Format and Content” tab parameters to look like Figure 5.  First 
check all the settings except the first one, “Outline Format”, and then proceed to 
that one in Step 6. 

 
 

Step 6

 
Figure 5: Outline Export settings – Format & Content Tab 

Notes on “Format and Contents” tab:   

• Although you may find the “Default” format acceptable, you will 
probably want to customize the Outline Format. (Figure 5 shows the 
“Report” format selected, which you’ll create in Step 6 below.)  

• Check “Optimise for Word” – this is the major new feature of Alpha1 
(and that’s the British spelling for optimize, so it’s OK!);  

• If you are using “Small Icons” in your maps (which in any case I 
recommend for saving screen real estate), then you can also “Include 
Images”.  Using the icon images from the map is a nice way of creating 
more continuity between the session and the notes. 

• Dialogue mappers will always want to “Include all node detail pages”! 

 
6. Customizing Outline Formatting.  Almost all of the formatting that you’ll need to 

set up for Compendium reports can be on the “HTML Formatting Options” screen 
(see Figure 6).   
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Figure 6: Outline Formatting Options, BEFORE and AFTER customizing 

 

• The quickest way to get a customized format is to download the “Report” format 
that I have created and install it.  You can get the file at 
http://cognexus.org/Compendium/Report.zip ; unzip the file “Report.properties” 
and extract it into the System/resources/OutlineStyles3 folder in your Alpha1 
Compendium installation folder.  The next time you click the drop down menu for 
“Outline Format” on the “Format & Content” tab, you will have the option to 
select the “Report” format.  (In the future we will probably have other formats 
available on the Compendium page; for example, for denser and looser line 
spacing.) 

 

• If you would rather have the flexibility to customize the styles manually, then you 
can try using these settings by entering them into Format Node Data section.  The 
buttons at the bottom of the section are very handy for this process, and well 
explained in the Help.  Here are the values I used in the “Report” format for seven 
levels of outline, Heading, Level 1, Level 2, Level 3, Level 4, Level 5, and Level 
6: 

                                                 
3 Normally the full path will be C:\Program Files\Compendium\System\resources\OutlineStyles.  Note:  
Compendium has many supporting files and folders that require frequent access, e.g. the Exports f older.  A 
good practice is to put a shortcut to the Compendium folder on your desktop.  The normal location for the 
Compendium folder is C:\Program Files.  Make a shortcut for C:\Program Files\Compendium and cut/paste 
it to your Desktop. 
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Column Name Value(s) 
Left Margin 0 for Heading, increasing by .25 for each successive 

level 
Top Margin .054

Font Times New Roman 
Size 12 (except for the Heading Label: 16) 
Style Bold for all Labels 
Text Color Black for Label and Detail 

 
• When you are done, Save your settings as a new outline format which you can 

then use for future reports. 
 

 
7. Make sure that your “Node Anchors” parameters to look like Figure 7. 

 

 
Figure 7: Outline Export settings – Node Anchors Tab 

8. Click Export to create the HTML output file.  Name the file “Compendium 
outline” and click Save. 

                                                 
4 .05 inches between lines gives enough space that the Small Icons are not overcrowded.  If you don’t 
include Small Icons, or if close packing is OK, then you can get even more text density with a setting of .0 
for the top margin. 
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9. Create a Shortcut to this file in Windows Explorer and place the shortcut on your 

Desktop.  What you’re doing here is setting it up so that you can export to HTML 
and read that (temporary) file into Word with as few steps and keystrokes as 
possible. 

 
10. Done!  You are now ready to create lovely professional outline reports in under a 

minute! 
 
Are these the best or right settings?  No, they are just my personal preferences, based on 
my experience to date.  Obviously there are thousands of possibilities, and you may well 
find settings and combinations that work better in certain situations.  I hope you will 
share them with me.  Perhaps we can create a library of templates, macros, and style 
guides for different kinds of reports. 
 

Creating Outline Reports in Word 
 
The process of getting a map or set of maps from Compendium into Word takes two 
steps, as mentioned above.  The first step is creation of a temporary HTML export file.  
 

Creating the HTML file 
 
Here are the sub-steps to creating the temporary HTML export file in Compendium: 
 

1. In Compendium, select File, Export, Web Outline. 

2. Press the Export button (you’ve already set up the parameters) 

3. In the File Name field click on the “Compendium outline” file.   

4. Click Save and then click “Yes” to overwrite it.   

 

Creating the Word document 
 
Now in Word … 
 

1. Click on File, Open 

2. Go to Desktop and select “Compendium outline”.5 

3. Click File, Save As 
                                                 
5  I have created a Word Macro which does Steps 1 and 2 with a single button click, making the process of 
getting from Compendium to Word even faster. 
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4. Create a suitable file name and save as type “Word document (.doc)” 

5. In the Edit menu, in the Links dialog, check the box for “Save picture in 
document”.  This will make sure that the people you send the Word document to 
see the icons; otherwise they’ll see broken links. 

 
That’s it!  You probably want to do some more clean up … add logos, a summary, a table 
of contents, etc.  You may even want to rewrite the text, creating standard paragraphs 
with full sentences, bulleted lists, figures, etc.  At least you now have a compact starting 
point for crafting your meeting report document. 
 

Cleaning up the Word document 
 
It is very useful to work with the styles in the document.  First, select Normal View 
(under the View menu).  If you haven’t done this before, open the Style Area on the left 
edge of the window by going to Tools -> Options ->View tab and setting the Style Area 
width (at the bottom of the window) to about .5.  Now you can see the styles that Word 
has assigned each of the “paragraphs” in the document. 
 
Compendium has reserved the style “level0” for map Labels, the names of the map or 
maps you have exported.  The other styles are fine and you can work with them as you 
usually would.  But the first thing I do is a global replace to change all “level0” styles to 
“Heading 1”, which is special style that word uses for creating tables of contents (along 
with the other heading styles, Heading 2, Heading 3, etc.).  
  
In Word 2000 and older, change all the level0’s using “Replace”: you click the “More” 
button, click the cursor in the “Find what” field (but don’t type anything), click Format, 
Style, and select “level0” from the menu; then click in the Replace with field, and set the 
style for “Heading 1”.  If you create a lot of reports you could even create a Word macro 
to do this in a single keystroke.  
 
In Word 2002, you can right click on the text in level0, select “Select Text with similar 
formatting”, then choose Heading 1 from the drop-down style menu. 
 
If you are creating a report from a large set of maps, you will probably want to take 
advantage of the Heading styles to organize the sections for the maps into a hierarchical 
structure that mirrors the map nesting structure in Compendium.  For example, if Map A 
contains Maps B and C, in the outline A should be Heading1 and B & C should be 
Heading2.  This way you can very quickly produce a table of contents for a larger 
document and the document structure would correspond to the map nesting structure.  
Word’s Outline View is especially useful for this sort of structuring. 
 
The other thing I always do with an outline document is look for spelling errors.  If I find 
any, I select and copy the misspelled word, Alt-Tab over to Compendium, Ctrl-f to bring 
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up Search, Ctrl-v to paste the word into Keywords, and then click OK.  Compendium will 
find all the nodes with that misspelling, and I can edit them right there in the Search 
Results window by double clicking on each node’s icon.  That way, if I ever need to 
come back later and use those maps or print them out again, I have corrected the spelling 
problems at their source. 
 
Studying the outline version of a map teaches you the subtle consequences of choices you 
are making as you create and link nodes in Compendium maps.  For example, when 
creating the maps, the choice of what’s in the Label and what’s in the Detail can have a 
big impact on the readability of the outline output.  It’s a good idea to routinely create 
and study the outline view of meeting maps.  If nothing else, Word will point out spelling 
and grammatical errors!  Ultimately, creating and linking nodes in ways that create 
flowing outlines teaches you how to make maps that are easier to read as well. 
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